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Software Starter Guide

(For the Canon Digital Camera Solution Disk Version 23)
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You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.

InstaII the @ Connect the camera
software to the computer.
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Windows = (p. 10)
Macintosh=p (p. 49)

¢ This guide explains how to install the software programs and
briefly introduces their functions and operating procedures.

¢ Please read the software license agreement that displays during

installation before using the software on the supplied CD-ROM. ey
You must accept the terms and conditions of the software Exif Print
license agreement to use the software. ™
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct
use of the products and to prevent injuries or damage to yourself, other persons and property.
Please read and ensure that you understand them before proceeding to other sections of
the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments

* ArcSoft, the ArcSoft logo and ArcSoft PhotoStudio are trademarks or registered trademarks
of ArcSoft, Inc.

e Adobe is a trademark of Adobe Systems Incorporated.

e CompactFlash is a trademark of SanDisk Corporation.

¢ Macintosh, Mac OS and QuickTime are trademarks of Apple Computer Inc., registered in
the United States and other countries.

« Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

e Other names and products not mentioned above may be registered trademarks or
trademarks of their respective companies.

Copyright © 2005 Canon Inc. All rights reserved.
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This chapter explains what you can accomplish using the camera with the software contained

on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide
¢ The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.
¢ The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.1.5-v10.3)
Memory card is used for CF cards, SD cards, MultiMediaCards and PC cards.
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It's so Simple! Make Prints Right at Home Like a Pro | 4

It's so Simple! Make Prints Right at Home
Like a Pro

(— Shoot the images _\
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See your Camera User Guide for shooting instructions.

Install the software on the
computer

Windows (p. 10)
Macintosh (p. 49)

Just install the software once at the beginning.
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( Connect the camera to the computer —\

(p. 96)
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Windows (p. 15)
Macintosh (p. 51)

Windows (p. 21)
Macintosh (p. 56)
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Unbounded Possibilities with Entertaining
Software

Print a Variety of Layouts
Print with the diverse layouts available in PhotoRecord (Windows) and ImageBrowser
(Macintosh). The examples shown are from PhotoRecord (Windows).

Make your own photo
album of precious

<
moments. on theboat.g
>

<

5
Yy
b3

=
=
[-]

2,
=2
2

=

Our Vacation

Beautiful sky, beautiful beach. i i i
util sk, beautful bes Confirm 9|I your images in one
glance with index (contact sheet)
y printing.

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.
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Send an Image as an E-mail Attachment

Attach an image to an e-mail message by starting your mail software from within
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

'

Operate the Camera Shutter from the Computer

Release the camera’s shutter from the computer with ZoomBrowser EX (Windows) or
ImageBrowser (Macintosh). The recorded image is saved directly to your computer.
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Release the shutter from the computer.

Edit a Movie

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

Convert a RAW Image

RAW images are extremely high-quality images that are free of the resolution loss associated
with compression processing. However, since RAW images are a special type of image, it is
necessary to convert them into standard images. You can make fine adjustments to the image
quality and coloration when they are converted.
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System Requirements

Please install the software on a computer meeting the following minimum requirements.

0 ¢ A CD-ROM drive is required to install the software.
¢ Even when system requirements are met, not all computer functions can be
guaranteed.
¢ A sound card is required to play movie file audio tracks under Windows.
¢ With Windows, QuickTime 6.5 is required to play or edit movies or to save
images merged with PhotoStitch as QuickTime VR files. QuickTime is included
on the Canon Digital Camera Solution Disk.
¢ Macintosh software cannot be used on disks formatted in the UFS (Unix File
System) format.

0S Windows 98 Second Edition (SE)

Windows Me

Windows 2000 Service Pack 4

Windows XP (including Service Pack 1 and Service Pack 2)
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Computer Model The above OS should be pre-installed on computers with built-in USB

ports.
CPU Pentium 500 MHz or higher processor
RAM Windows 98 SE/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more
Interface uUsB
Free Hard Disk e Canon Utilities
Space - ZoomBrowser EX: 250 MB or more
(Including the PhotoRecord printing program)
- PhotoStitch: 40 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more

Display 1,024 x 768 pixels/High Color (16 bit) or better




System Requirements | 9

(0} Mac OS X (v10.1.5-v10.3)
Computer Model The above OS should be pre-installed on computers with built-in USB
ports.
CPU PowerPC G3/G4/G5 =
RAM 256 MB or more 2
£
d
Interface UsB ?
Free Hard Disk * Canon Utilities 5_
Space - ImageBrowser: 200 MB or more 95_
- PhotosStitch: 40 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more
Display 1,024 x 768 pixels/32,000 Colors or better




This chapter explains the basic procedures for installing the software and connecting the
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

PhotoStudio.

Iﬁl See ArcSoft PhotoStudio (p. 81) for details on how to install ArcSoft

ltems to Prepare

 Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.




Installing the Software and USB Driver

3 Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

(dip
3. Double-click the [SETUPEXE] “x icon.

Windows 2000, Windows Me, Windows 98 SE
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

Ediny
3. Double-click the [SETUP.EXE] \vjj icon.
Some computers may not display the [.EXE] file name extension as shown above.

4 Click the Digital Camera Software
[Install] button. Canon DIGITAL CAMERA

Solution Disk

Digital Camera Software
:—7;

QuickTime

Install

Exit

|
Installer Panel

Follow any instructions to restart your computer, if they appear. If the
following window appears, continue with the installation.
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5 Click [Next].

Canon Digital Camera Solution Disk g

Welcome to the InstallShield Wizard for Selution
is

The InstallShield® Wizard will install Solution Disk on pour
computer, To continue, cick Next

6 Se|GCt [Easy InSta”atlon] as the Setup Canon Digital Camera Solution Disk
type and click [Next]. Setup Type

Choase the setup type that best suits your needs.

Select [Custom Installation] to select e e e
programs individually for installation. :

Desciption

Instalk allthe programs, We
vecommend this option for users
unfamiliar with the installation

When [Custom Installation] is Selected
The USB driver (the software for connecting) is required when the camera
is connected to the computer with an interface cable. Ensure that you
select a USB driver from below (the appropriate one for your operating
system).
*Windows 2000/Windows 98 SE: Canon Camera TWAIN Driver
e\Windows Me: Canon Camera WIA Driver
With Windows XP, the USB driver supplied with the Windows operating
system is used so there is no need to install a USB driver.

7 Click [Yes] if you agree to all of the terms of the software license agreement.
8 Review the installation settings and

Canon Digital Camera Solution Disk:

click [Next]. Start Copying Files
. . FReview settings before copying files.
Follow the onscreen instructions to &
Setup has enough information o start capying the program files. | you want o review or
p roceed . change any setlings. dlick Back. If you are satisfied with the sattings. click Mext to begin
copying files.

Cunent Settings:

Destination Folder:
C:AProgram Files\Canon

Progras (0 be installed

The items displayed here differ according to A
the software installed. ZuomBrowser EX/PhotoRecord




Installing the Software and USB Driver | '|3

Q When the installation is over, select
[Yes, | want to restart my computer
now.] and click [Finish].

Canon Digital Camera Solution Disk

InstallShield Wizard Complete

The Installs hield Wizard has successfully installed Solution
Disk. Before pou can use the program, you must restart your
computer.

# Yes. | want to restart my computer now.

Mo, | will estart my computer later.

At this stage, do NOT remove the Solution
Disk from the CD-ROM drive yet.

Click Finish to complete setup,

(E)

Users of Windows XP and Windows 2000 must log in as an Administrator
(computer system administrator) after restarting to carry out the
subsequent procedures.

10 Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Continue by connecting the camera to the computer so
that the USB driver can be utilized.

0 If you installed a USB driver, so far the required files have only been

copied to your computer. You must now connect the camera to the

computer with the interface cable to complete the installation and
prepare the driver for use.

Iﬁl See Uninstalling the Software (p. 83) to delete the installed programs.

11 Attach the camera to the computer with the
interface cable and set the camera to the
correct mode for connecting.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See Information about Your Camera (p. 95).
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If the Digital Signature Not Found window [ =
appears, click [Yes].

The Microsoft digital signature affirms that software has
been tested with windows and that the software has not
been altered since it was tested

The software you are sbout to install does not contain a
Microsoft cigital sianature, Therefore, thereis no
guarantee that this software works comeetly with
Windows

HHHHEHRHHRE

If you want to search for Microsoft digitaly signed
software, wisit the 'windows Update Web site at
hitp:/windomsupdate miciasaft.com ta see f aneis
avaiable.

Do wou want ta continug the installation?

Yes No More Info

The USB driver will automatically finish installing onto the computer when you attach the
camera and open a connection.

Dialogs similar to the following will appear during this process (first time the camera is
connected to a computer only).

Windows XP
The dialog on the right will appear after a
few moments. @

) Found New Hardware |*| [Recycls Bin

Canon Digital Camera

Windows 2000/Windows Me/Windows 98 SE
Restart the computer according to the instructions if you are prompted to do so by a
message.

A dialog allowing you to set the default settings will display after installation. See Using
the Software on the Windows Platform — The Basics (p. 15) for the subsequent
procedures.

*See USB driver installation not proceeding well in the Troubleshooting
section (p. 87) if you are having problems installing the USB driver.

e See Uninstalling the USB Driver (p. 84) to delete the USB driver installed
with these procedures.

e See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 94) if you
were previously using either version.

This concludes the software and USB driver installation and the procedures for connecting the
camera to the computer.
You may now download camera images to the computer (p. 15).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the Windows
Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 19).

You can also display an index of the camera or memory card images to check
them before downloading or to download them selectively. For instructions,
see Checking Images before Downloading (p. 34).

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 95).

The Camera Control Window will appear.

! CameraWindow - Canon XXXXXXXXXXX

Acquie Images | Setto Camera | Remate shooting|

Davirloads using camera

(O

1 Press the camera's button

i3

Camera Control Window

Downloads using computer

Starts to download images

Lets you select and download images

i |

Displays this screen when the camerais connected
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First Time Camera is Connected to a Computer
Set the following settings the first time you connect the camera to the computer. These
procedures are not required from the second connection onward.

Select [Canon CameraWindow] when a
dialog (Events dialog) similar to that on
the right displays and click [OK].

Camera connected

Your camera model name or [Canon

Camera] will appear here. Select the pragram to launch for this action:
A
Different programs may display <§ n Canon Camery 1
according to your computer setup. _i 2= Microsoft 5 canner and Camera \Wizard
Download pictures from & camera or scanner
b

[ Always use this program For this action

If this Events dialog does not appear, click the [Start] menu and select
0 [All Programs] or [Programs], followed by [Canon Utilities],
[CameraWindow] and [CameraWindow].

2 Download the images. [ 8 ComeraWindaw - Canun XXRO0000
Download the images using the camera or ‘cauire mages | e to Camers | Remots shootng
the computer. By default, the downloaded i e s
images are saved into the [My Pictures]
folder. o @JQ‘N Press the camera's button
=

Downloads using computer

gl Starts to download images

>
[ oy :

g@ Lets you select and download images
&=

Displays this screen when the cameta is connectad

You can adjust the settings, such as the type —1 £ o, | [

of image downloaded and the destination
folder, by clicking [Preferences].
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Using the Camera to Download Images (Direct Transfer Function)

e If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
yas (Print/Share) button will light if your camera is equipped with one.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the

camera and press the $has (Print/Share)
button or the [SET] button.

Direct Transfer
s All Images...

New Images...

DPOF Trans. Images...
[ Select & Transfer...
& Wallpaper...

Using the Computer to Download Images
Click [Starts to download images].

8 CameraWindow - Canon XXXXXRAXRKX

Acquire Images | Set to Camera

Remote shooting

Dowrloads using camera

o QO

Press the camera's button

@l !
2 Starts to download images
£ B

=pll| Lets you select and download images
|

n when the camera is connected

¢ By default, all the images that have yet to be downloaded wiill
download.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded

The downloaded images will be saved into folders according to their shooting date.
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By default, when downloading is complete, prr——————
the thumbnails (tiny versions) of the o oW B B B B @

ZoomMode | Scal o | Pravin s,

o0 € + ¢ BB (2]@ A 8 ] [l soa[Amon 9]

downloaded images display in (]
ZoomBrowser EX's Main Window.

Thumbnail

Shows the folder where the images are
saved.

Seeaiens:o

Next, print out the images (p. 21).
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Memory Card Reader Connection

T  insert the memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card reader for its connection and handling instructions.

P (2) Insert the loaded adapter into the slot.
y

(1) Place the memory card in an adapter if required.

The card adapter and memory card shape may vary according
to the type of memory card your camera utilizes.

=T View a slideshow of the images
uzing windows Picture and Fax Viewer

_i728 Copy pictures to a folder on my computer
uzing Microzoft Scanner and Camera “izard

2 select [View/Download Images using
Canon CameraWindow] when the
dialog to the right appears and click
[OK].

The Camera Control Window will display.

Wiew Images L3
Lizing ZoomBrowser B

| &hways do the selected
0K Cancel
g

If the dialog above fails to appear, click the [Start] menu and select [All
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow]
and [CameraWindow], and proceed to Step 3.

3  Click [Starts to download images]. T ——————

Acquire Images \ Set to Memory Card

,,gl Starts to download images

ﬂd@ Lets you select and download images
=
You can adjust the settings, such as the type — | Peferences |

of image downloaded and the destination
folder, by clicking [Preferences].




Downloading Images to the Computer

¢ By default, all the images that have yet to be downloaded will
download to the [My Pictures] folder.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

¢ See Memory Card Folder Structure (p. 86) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ZoomBrowser EX’s main window.

Next, print out the images (p. 21).

20




Printing Images

Printing Images

This section explains the basic procedures for using PhotoRecord, a printing utility program. See
the program’s [Help] menu for more details.

* Movies cannot be printed.

*With images shot by Exif 2.2 (called Exif Print) compatible cameras, shooting
information such as the shooting settings and mode can be included with
the images. This data is then used to correct the images to obtain better
prints.

* PhotoRecord automatically carries out image correction (by default) both
with images shot with Exif 2.2 compatible cameras and other images,
yielding high-quality prints.

1 cick [Print] in ZoomBrowser EX's Main Window, followed by [Layout Print].

£7 ZoomBrowsen EX_ - D:\Documents and Settingsboodhy Documents\My Pictures

&7 ZoomBrowser EX. - D:\Documents and SettingsboodMy Documentsiiy PicturesiF lowerk20

Fie Edt View Tools Internet Help
5 Fie Edt Vew Toos Intemst Help
G oo i
e B3] view 1moge Properties @smesnuw @Seavth
[7Cl iy Zoom Made | ScrollMods. 3 —
= 20040909 + ERAS( @ a Zoom Mode | Sorol Made | Preview Mode! .
[ vens = 2004_09_09 t k-8 (ke
E View R Classiy
@ Edt
@ e
-
Layout Pint
Contact Sheet Print 3 ‘
=

2 Confirm that [1. Select Images] is selected and proceed to select images.

D:ADocuments and Settingsbooibly Docume p £s12004_09_09 ]
Fle Edt view Tooks Internet Help

Zaom Mode | Scioll Mode | Preview Mode |

t k-2 (k|| o [/ show | Alimeges 3

Select Images

Select Captions for Printing

3. Open Layout Frint...

The background of the
selected image(s) will
turn blue. 2 Retum o M berws

Favorte Folders| Al Folders

0 2004 07_02
) Flower
) Image Library One
() movie
) movie2
12 My eBooks
My Music
= My Pictures
1) zo04_p9_07
{5 2004_n9_ng 9

1>

Add to Favorites

Selected Items: 7
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3 CIICk [2' SeIeCt Captlons for Prlntlng] o7 ZoomBrowsen EX - D:\Documents and SettingsboodMy Documentsibly PicturesiFlower12004_09_08
and place a check mark beside the type [ =i v ik mane
of information that will be printed with
the images.

‘You can choos to attach o sach image any or all ofthe prop

O Comment

If you select [Date and Time], for example,
you can print the images with their shooting
dates and times included.

Iﬁl You can add a comment to an image in the Properties Window (p. 31).

4 Cick[3. Open Layout Print]. R T R D S D

File Edit Wiew Tools Internet Help

Select Images
2 *¥ou can choose to attach to ea

Select Captions for
[ comment
[ File Nare
Date and Time

PhotoRecord will start, displaying the
selected image and the information
selected in Step 3 in the Album window.

In addition, the steps that will take you
through the printing process will display on
the left side. Follow the steps in order to
proceed.

Cieflard arag photos ar -2k fo optons

Album Window
The selected images display
here.

The printing procedures display here.

From this point onward, the procedures vary according to whether you select Full Page
Print (prints one image per page) or Layout and Print (prints an arrangement of images on
each page).
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Full Page Print

This option prints one image per page.

1 cick [2 Select Printer & Album Type].
Once you have chosen a printer, select

[One Photo Per Page] or [One Photo Per

Sheet] in the Album Type category.

2 Click [3 Select Paper] and select the
paper size and orientation.

3 Click [4 Print], confirm the number of
copies and other printing settings, and
click [Print].

This will start printing.

{24 Untitled - PhotoRecord

File Ecit View Alum iternet Help

Printer

Canon GOHGHNH
Properties

Select Printer Album Type
[ 2 & Album Type
One Photo Per Page
N
A Automatic Clipping
Select Paper
I Borderless Printing
Overprint Distance
Album
hiargins

@ Add Titles |

©
@
N
=1
S
=
©
@
N
N
>
4

{24 Untitled - PhotoRecord

File Ecit View Alum iternet Help

Printer
Canon K0

|jia Fetch Photos

Select Printer

& aum Type | Biedia Type

Pheto Paper Pro

IFaper Size

Page Crientation

Decorate ‘

Alburn @ o=
= I
] Select Paper i e
Copies T =

© Pages

Add Titles
& Captions

Prirt Pages
Decorate
Aburm @ al

Click and drag photos of right-click for options

Letter ™ I

©
<
Frirt

WWVIZZ:51:6 $00Z/6/6

NWZe:Sl
<

Pai

3

Al

To close PhotoRecord after printing is complete, click . Click [Yes] to save the album or [No]
to close it without saving. The ZoomBrowser EX window will reappear when the save

procedure is complete.
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This option prints multiple images on a single page as in a photo album.

1 cick [2 Select Printer & Album Type].
Once you have chosen a printer, select
[Free Form] in the Album type category.

2 ik [3 Select Paper] and select the
paper size and orientation.

3 Click [Decorate Album] and change the
design of the image background and

{24 Untitled - PhotoRecord

File Ecit iew Alum iternet Help

Canon HHHGH000

Properties
Select Printer Album Type
= & Album Type

Select Paper (& Front Cover

[ Back Cover

O Paige Numbers

* Decorate
m Blhum

My Album

{54 Untitled - PhotoRecord

File Edit ‘iew Aloum irternet Help

Printer
Canan KKHKKIGH

Select Printer

& atbum Type |l Mesia Type

Phto Paper Pro

Paper Size

Letter v

Patje: Oriertation

@ [3 O =

Decorate
Albumn

7001 21522 AN

My Album

Fromt G

{23/ Untitled - PhotoRecard

File Edi ‘iew Album Inernst Help

border as desired.
I

Click the [Themes], [Backgrounds], [Photo
Frames], [Text Frames] or [Clipart] button to
switch between selections.

Perform the procedures according to the
instructions beside the [1] symbol.

a Fetch Photos

Please select one or mare
A photos to apply newy frames:

|@'§ Select Printer | | photo Frames
& Album Type

Select Paper

5 Decorate My Album
Album
Front (
ET Add Titles
& Captions
-2 [
2 = Qe
Click and elrag phetos or right-click for options

¢ The [Themes] category provides consistent designs for use throughout
an entire album.

*You can also click [Add Titles & Captions] to add text as a title or caption.




Printing Images | 25

4 cick [4 Print], confirm the number of ; Select Paper [JRRSSEREE RS W
copies and other printing settings, and B B
click [Print]. : m;m i My Album

O pages Fromt G

Add Titles
& Captions

Click and drag photos or right-click for optians

This will start printing.

To close PhotoRecord after printing is complete, click ﬂ Click [Yes] to save the album or [No]
to close it without saving. The ZoomBrowser EX window will reappear when the save
procedure is complete.

There are numerous varieties of albums. Select one to suit your purposes.
Please note that the available aloum types may vary slightly according to
the printer in use.

Album Type Description

One Photo Per Page
One Photo Per Sheet

Prints one image on each sheet of paper.

Allows images to be freely positioned on the page

Free Form and printed.

Prints thumbnails of the images and their shooting
data (Exif data*).

Allows image heights and widths to be specified and

Contact Sheet

Fixed Size Photo

prints.
Mosaic Lines up the specified number of images and prints.
Perforated Paper Prints on perforated paper.
8-Sticker Label Prints on 8-label sheets.

* The shooting information displayed in ZoomBrowser EX and the Exif data
that can be printed using PhotoRecord differ slightly.

This chapter explained the ZoomBrowser EX basics. Once you have mastered them, try the
advanced techniques.
Using the Software on the Windows Platform — Advanced Techniques (p. 26).



This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Area (p. 27) Function Buttons (p. 29)

7 ZoomBrowsei EX. - D:\Documents and Settingsboodiby Documents\hy PicturesiFlower\2( 04_09_09.

L S Display Mode

w Asauie & Camera Settings ( LI )

i—ﬁ amapgos & o & B-B- (K@ 0 o F [ show | Almages 7 (p 28)

& e [

B Display Control
& e Panel (p. 29)

-

q
Favar

oo & M6 300205 16005556 16 600406
Doz |
=) Flower
2 200409 07
15 2004 0802 |
5 2004 09 05
{5 2004 093¢
) 2004 0911 |
15 2004 0912
Movies M5 0005.pG IMG_0006.PG MG 00076
1) travelogue
£ summer vacation ]
< i | @

Ao Fanortes ¥

| Selected Ttems: |

Browser Area (p. 27)

Folders Area (p. 27) Switches between showing and hiding
the Task Area and Folders Area.



The ZoomBrowser EX Windows

Task Area

e ZoomBrowser EX's tasks are arranged here like v (@) s (G5 (G s
an index. TN Zomvior [zovioss =
» Click a Task button to carry out the desired task. |'& =
These features are described in ZoomBrowser & -
EX Features (p. 32). Bt
S -
gzss:;s:::i%\:

Folders Area

e Use this area to select folders. The images in the selected folder display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

* If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder

o If [Favorite Folders] is displayed: click [Add] and select a folder.

o If [All Folders] is displayed: select a folder and click [Add to Favorites].

¢ To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Browser Area

¢ The images in the folder selected in the Folders Area will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area
e Selecting a single image: click on an image.
e Selecting multiple images: click on the first image and then hold the [Ctrl] key down

while clicking on additional images.
e Selecting consecutive images: click on the first image and then hold the [Shift] key down

while clicking on the last image.

*You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by clicking the [Tools] menu and selecting [View] and [Sort by].
¢ The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode
i RAW images

b=l Movies

Images with sound memo attachments

E Protected images

Images shot with the camera's AEB function
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Display Mode

o Selects the display style for the Browser Area.

Zoom Mode
Displays all the images in a folder as thumbnail  |fo———""%% G Qo B B
images. This mode is convenient for searching | [f@ comcmsam | [Z= 5
for images since many can be displayed at B || |
once. &
B o

If additional folders are nested within a 21

folder, their images are displayed as @ rere n

thumbnails as well. oo APl |

D201
5 2004 091z

Scroll Mode
This mode is convenient for checking the e G Qo o B

. . ; (2= o@-+= @-
images in multiple folders at once. If the B8 || o er [remri]
displayed folder is at the highest level, then all

thumbnails in the lower-level folders also
display. You can change the folder level (folder
depth) by clicking the [Tools] menu and
selecting [Preferences].

H thi [SECATIENN
The images within nested folders also S
display. Sgmmnn
1) 2004_09_0%
D4 09ac |

S HE S wErE = o

P review M od e #7 ZoomBrowser EX - D:\Documents and SettingsboodMy DocumentsiMy Pictures\Floweri2004_09_09

This mode displays the image at a larger size as | &)@ wme B Ssaen G o @0
(F78 acaies comasatings ||| Zoom Mode | ScroliMode | Preview Mods |

well as the image information.

2004_03_03 € >+ B

Dowoim A
D) 2004 0428 U

2 Flower,

2 2004 09 07
{2) 2004 09_0¢
1) 2004 09 0%

5 2004 01c| < P
1) 2004 09_t1

Positioning the mouse pointer over a thumbnail causes the image to display
at a higher magnification. You can turn off this function by clicking the
[Tools] menu, selecting [Preferences] and removing the check mark from the
[Show mouse over windows] option.
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Display Control Panel
¢ This panel adjusts the display settings for the Browser Area.
Selection Menu Display Size

Use this to select or deselect all  Changes the size of the thumbnail in
the images in the Browser Area. the Browser Area.

- = 4 @ - k& O _J I:l Show | All Images v
Show/Hide Image Information Menu Filter Images
Use this to display or hide image This feature filters your images by
information beneath the thumbnails, their Star Ratings, displaying only
such as the file name, shooting date those images in the Browser Area.
or Star Rating. One of three Star Ratings can be
assigned to an image in the Viewer
Select Button Window, the Properties Window, or
Use this to select images in the information column in the
in Zoom mode. Preview Mode.

Function Buttons
¢ These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
in the Viewer Window. selected images. image.

s = - =
E Wiew Image E] Propetties D.?f' Slide Show a Search ﬁ Delete gj Riokate -

\_‘

Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteria asthe images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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|3o

Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu

You can use this
menu for red-eye
correction, image

Split Screen Button Show AF Frame
Displays multiple images at once. Displaysthe AF Frame
This is handy for comparing images. (area used to focus).

correction and
trimming. You can
also use it to start up
other programs for
editing.

Image Selector Button
Switches between
images.

Synchronize Button
Synchronizes the
display settings when
multiple images are
displayed.

Star Rating
Sets the Star Rating
for an image.

ZoomBrow: ex EX - Di\Documents and Se1 ingsbooiMy Doct mentsiMy Picturesi2004.07_02umG_0001.9p6. (=] 1)K

Fie Edt View| Help

Zoom Ratia: 44%

D - (mEIs) a o
we_omLws | 00— E iﬁ gzg}

Setsthe image display — 1

size to the size in the
Viewer Window.

Zoom
Changes the image
zoom setting.

Full Screen Button

Displays the image in the full screen mode. Click the
image or press any key on the keyboard to restore the
normal display mode.
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categorles. EB Properties [zl
. Maodified 5/2/2004
Star Rating File Size: 4706 KB
Sets the Star Rating Image Size: 1500 % 1200
for an image_ File: Type: JPG
Sound:
Flaysond ————3+— Plays a sound memo attached
Path D:4Documents and Settingsiss\My Docu toon image.
{7 | File Mame:

(M5 _nom |

[&] Star Rating: Protect . )
[ <de<be<'c b Prevents an image from being
otect .

overwritten or deleted.

[ Comment: EEE—

Comment
You can type a comment here.

Keywords Keywords
Sets the keywords used in
searches.
Histogram:
|-— Histogram
A graph of the highlights and
shadows distribution in an
[ eeeee— i
Shooting Information —— Image.
Displays detailed — —
information about the IMG_0001 JPG =
shooting settings when the | " Mot Name
image was captured, such Shooting Diate. Time =
as the shutter speed or =
exposure Setting_ The [ < Previous Mext > ]—— Image Selector Buttons
camera model will Switches between images.

determine what
information is displayed.
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ZoomBrowser EX Features

This section briefly introduces the Task Area functions.

Acquire & Camera Settings

o
Opens the Camera Control Window, which lets ‘@ Acquire & Lamera Settings ‘
you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 15, 19).

Set to Camera
Sets camera settings, such as the My Camera settings (p. 45), or Slide Show/DPOF settings. It
also uploads images from the computer to the camera/memory card.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 41).

View & Classify = .
View as a Slide Show |¥ Wiew & Classify

Starts a slide show of the images selected in the
Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.

Edit
Edit Image ‘@ Edit
Allows you to perform image editing, such as

trimming, image correction and red-eye

correction. You can also use it to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 44).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music,
and apply various effects (p. 37).
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Process RAW Images
Converts RAW images into standard images. You can adjust the image brightness, contrast
and color balance among other attributes during conversion (p. 38).

Export
Export Still Images ‘@ Export ‘

Allows you to change the image size or type,
and export it as a new image.

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text
file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.
*\Windows XP is preinstalled
¢ A CD-R/RW drive is included as standard equipment

@‘ Frint ‘
Contact Sheet Print

Prints the selected images as a contact sheet (index).

Print

Layout Print
Allows you to arrange the selected images in an
attractive layout and print them (p. 21).

Internet

Email Images

Converts the selected images to the appropriate
size for transmission by e-mail. You can also use
it to automatically start an e-mail program after conversion.

ir..

\[@ Internet ‘

¢ To return to the previous screen after selecting a task, click [Return to Main
Menu] at the bottom of the task screen.
¢ Various Help functions are available in ZoomBrowser EX. Click the [Help]
menu, [?] button or [Help] button to display topics about operational
procedures or the functions available.
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Checking Images before Downloading

You can display camera or memory card images in the Camera Browser Window to view them
before downloading.

1 Perform Step 1 in the Camera to Computer Connection section (p. 15) or steps 1-2
in the Memory Card Reader Connection section (p. 19).

The Camera Control Window will display.

2 cdlick [Lets you select and download .

images].
3 Starts to download images

i@ Lets you select and download images

+

([

Displays this screen when the camera is connected

The images in the camera or memory card will display in the Camera Browser Window as
thumbnails (tiny images).

& CameraWindow - Canon JO0E0MGNK
Fie{F) Edit(E} Yiew(¥) Help(H)

By v | Medium ~| = B @

—1 CameraBrowser

Bright. | RGB WlndOW

Thumbnail

STA_DODIIPG STB_0010JPG STC_0011.JPG

STD_0012JPG

STA_D009JPG
Canon Kxxaxng

5/13/2004
308:33 PM

Detailed Image Information
[File Name: ~

STA_D009.JPG =1
[Camera Model Name

Fannn 57 DIRTAL |

3 select images to download.

To select multiple images, click on the first image and then hold the [Ctrl] key down while
clicking on successive images.

4 Click [Download pictures]. - e —
File(F) _Edit(EsView(V) Help(H)
(25 Download pictures | %y + [Medim v| =t 8

STA_0009.PG STB_00M0.UPG STC_0011.JPG
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5 Confirm the destination folder and click

CameraWindow - Download Images &‘
[Starts Download]. —
= Specify File Mame
. . . [ D& ot madiy v
Specify the file name for saved images. _| R
| |
Specify the destination folder for the _ | N —
images. Mumoer of Digts | |
You can change the destination folder by et [ |
clicking [Browse] and selecting a new
destination.
Select [Create subfolder] to create a new Spebiny Folder
folder within the one specified above, and Semie (e
select a naming option |D:\Documents and Settings\wesMy Documents\M | [ Browse... |
A subfolder into which the image will be saved will automatically be
created in this folder.
Create Subfoldsr
| Shocting eatonthDate v]
Mew Name
[ |
Example:
(1 D:ADocuments and Settings\wsiy Docus...\My Picture:
123 2003 1231
( [ Stats Download | J) Cancel ]
S e

The thumbnails of the downloaded images will display in the Main Window of
ZoomBrowser EX when downloading is complete.

You can also download images to the computer by dragging images
displayed in the Camera Browser Window and dropping them onto the
Browser Area or Folders Area in ZoomBrowser EX.

Other Methods of Downloading Images to the Computer
There is no need to install ZoomBrowser EX with either method.

* Windows XP (Installation of USB Driver Not Required)

Your camera uses a standard image transfer protocol called Picture Transfer Protocol (PTP).
With PTP and Windows XP, all you need do is connect the camera to the computer with an
interface cable to easily download images using the Scanners and Cameras Wizard or other
procedures. However, there are some inconveniences and limitations to this downloading
method. See the For Windows® XP and Mac OS X Users leaflet for details.

* Windows Me (with the USB driver installed)
Easily download images using the Scanners and Cameras Wizard or Windows Explorer. All
you need do is connect the camera to the computer with an interface cable.

See the Windows Help system for information about the Scanners and Cameras Wizard and
Windows Explorer.

35
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Replaying Movies

Installation Procedures for QuickTime
QuickTime is required to play and edit movies. To install QuickTime, please follow these
procedures.

1. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel fails to appear automatically, display it using the procedures in the
How to Display the Installer Panel section (p. 11).

2 Click the QuickTime [Install] button.
Canon DIGITAL CAMERA

Solution Disk

Digital Camera Software

Install

QuickTime

Exit

Follow the onscreen instructions to proceed with the installation.

1 Double-click an image with a movie T T———————T]

icon in ZoomBrowser EX's Browser “ » @ [0S O aa®
Area. wzseonn |E3] J B # % e ™

2 Click the |I| (Play) button in the
Viewer Window.

Windows Media Player or QuickTime Player
will start.

3 Ciick the & (Play) button in Windows
Media Player or QuickTime Player.

zoom Rato: 100%

Do not double-click a movie file in the Windows Explorer to play it. That will
start Windows Media Player, which may not support this file type. To replay
movies, start QuickTime Player through the [Start] menu and open the file
using the QuickTime Player [File] menu.
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

Procedures for QuickTime section (p. 36) to install it.

Iﬁl * QuickTime is required to play and edit movies. Use the Installation
* Movies are saved as Motion JPEG AVl movies.

Click [Edit] in ZoomBrowser EX's Main Window, followed by [Edit Movie].

2 Click [1. Add Images] and select the image (movie or still) you wish to edit.
You can select multiple movies or stills.

3 Follow the steps at the left of the window to edit the movie and save it.

Follow these steps Click this button for detailed
to proceed. operational instructions.

and SettingslkuraViy Documents\iy Pictures

To amange images. select the image and click on the [Move Left] or [Move Right] 1

buttons, J
— Instructions

J

Click this button to
- play the movie
(liREIGIEIEIS being edited.

Storyboard Area — | —— Transition Effects Box
Plsplays thumbnails of the selected Appears between adjacent images
images. and displays the symbols of the

Links images in order from left to right. transition effects linking images.
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Converting RAW Images

RAW images are extremely high-quality images that are not subject to any deterioration due to
compression processing. Since they are a special type of image, they cannot be opened by
many image editing programs. It is first necessary to convert them into standard image files.

¢ See Information about Your Camera (p. 95) to determine whether your
camera model supports this function.

¢ See the Camera User Guide for information about the camera settings for
shooting RAW images.

Procedures for Converting RAW Images

T selectarAaw image in ZoomBrowser EX's Browser Area.

2 Click [Edit], followed by [Process RAW Images].

Click [OK] when a window displaying procedures for converting and adjusting RAW
images appears.

The Main Window, the Navigator window and the Image Quality Adjustment Window
will display.

Use the buttons here to switch Main Window Navigator Widow
between images and display
modes, rotate images, and set
the conversion parameters.

Thumbnail
Check Mark

When the preview
image in the main
window is zoomed,
you can change the
portion shown in the
preview by clicking
and dragging this red
symbol.

select [Show Navigator].

Iﬁl If the navigator window does not display, click the [View] menu and

3 Adjust the image quality as required in the Image Quality Adjustment Window.
This window is explained in the Functions of the Image Quality Adjustment Window
section (p. 39).
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4 Ciick the [2. Save] tab, set the file type
and destination, and then click [Savel].

Select [All Images] or [Checked Images] J_

39

Z5RAW Image Task
Fie(F) EGHE) Vi

[ 1. Adjust Imagd

Conversion Tar
& Allimages

 CheckedImages

Canvertfrom RAW 1o Other Format

(images checked in the main window) to
apply the common conversion settings.

Select a file type

Set the file destination

You can also change the file name

.

Flle Format XTI @bivch) =
L S e |
Resolution: 180 pixelinch (10-2000)
o ™ Embed 1CC profe inimage
Save folder
& save in Origial Image foger
 ave in following specified folder
Name File
¥ Do Not Moy Assign Sequence No
Prefic Number of Digis: ©9
Start Number

This will convert the image.

B Click the [3. Exit] tab and click [OK].

Functions of the Image Quality Adjustment Window

The following adjustments can be made in the Image Quality Adjustment Window. The
available settings may vary depending on the camera used.

Image Quality Adju...
HRRRRRE R,

General Adjustments @ Tone Cu

(2]
” Tone Curve Tab
You can set the levels for

the RGB channels

[l Bl h separately or together
This section adjusts the st =]
white balance according Corlemesas ek Advanced Adjustments
to the light source and 12000 - 10000) Tab
color temperature. Faceni B =or You can set the settings
\_ [100-+100] J for adaptive noise
(" Digital Exposure Compensation_\ control and the color
L - g-g] space for the output.
This section adjusts foto Effect =] If you cannot set the
the digital exposure Contiast desired setting with the
compensation, photo o slider on the left, directly
effect, contrast, ) Shampness (5-+5) enter the setting here.
sharpness, and saturation. 7
5 aturation ’[D—-”EII]
L [-5-+5] Y
The effect of the settings | | . .
above can be viewed L ¥ Previe Help 44— Applies the settings to

immediately if you place a

the displayed image

check mark here.

Restores all settings to the settings stored

in the camera at the time

of shooting.
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You can change the coloration of the image to your preferred settings when
you convert a RAW image. You can also select preset color schemes, such as
Positive Film. Furthermore, you can add your own color schemes (My Color) to
apply to other RAW images when they are being converted.




Operating the Shutter Remotely 4]

Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between models. Some cameras
need to be in Playback mode when connected to the computer, please
refer to the Information about Your Camera section (p. 95).

¢ Perform the settings described in First Time Camera is Connected to a
Computer (p. 16) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 CIICk the [RemOte ShOOting] tab & CameraWindow - Canon XXXXXXXXXKX
4 Click [Starts Remote Shooting]. Acauie ages | St o Cafera] Famotesheing | |

Eox

EJ Starts Remote Shooting

Displays this sciesn when the camera is connected

5 sclect a destination for the captured images and click [OK].
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|

RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the
viewfinder or detailed
settings area.

Size and Resolution Selector
Selects the size and resolution at which images are captured.

Rotation Settings

RemoteCaptureTask alE Sets the rotation

File(F) CameralC) ShootingiS) Help(H) parameters for

(@) Hide viewFinder & a0 H [ images after they are
() Hide shaoting detaits | captured.

You can add
comments to images |/

[ Add comments shown helow

— Release Button

by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera'’s viewfinder.

Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the

Fizkl snglefiash viewfinder display.
Focusing Point: Flash:
|Manua| selection - Center j ‘Off

Shocting settings

| Refresh Button

Macro Resets the exposure,
[or =/ focus and white
AF-assist light: balance

On -

AF operation:

AF unlock 2

Set the basic camera settings here.

*The settings available in the RemoteCapture Task window vary between
camera models.

¢ RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click &g to reset these settings.
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Remote Shooting

Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

If your camera is equipped with the Auto Rotate function and you set it
to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window.

3 Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard's space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

* You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge images
if they are shot with the camera's Stitch Assist mode because PhotoStitch can automatically
detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

Symbol displayed by images shot in Stitch

Assist mode.

Assist mode.
eImages shot in Stitch Assist mode with a wide converter, teleconverter
or close-up lens cannot be merged accurately.

Iﬁl ¢ See the Camera User Guide for information about shooting in Stitch

Starting PhotoStitch

1 cik [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].
2 click [1. Select Images] and select several images in the Browser Area.

3 Click [2. Open Photostitch]. e
‘;_J Merge Images Shot i

Instructions

STAS P TR JPG

o of fnoges:

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

® Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera section (p. 95).

* Perform the settings described in First Time Camera is Connected to a
Computer (p. 16) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab.

& Cameralifindow - Canan XXKEXXKRKKK

CIICk [Se.t My Camera] . Acquire Img moke shooting
NG
i"@‘j Set My Camera
=)
”-é}b‘l Set Slide Show/DPOF
:%F Confirms/changes camera settings
=l
_%* Uploads images to the camera
Displays thiz screen when the camera is connected
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The My Camera Window Features

ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check

these items with the My Camera window.

Tabs

46

Click here to switch between adjusting the settings individually or in themed sets.

|

tmSetup as 3 theme  Set individually |

Displays the list of —

Data Type:

Select My Gamera Data type and sst individually.

[Startup Sound

settings files saved
onto the computer.

Add File Button
Adds the settings file

ANIMALDZZ SSOLWAY
ANIMALDZ SS01WAY
BAR2T_SSOT.WAY

. S5
FUNZZ-3501 WAV
to the list. FUND3.3301 WA
FUN S50 Wi
KT 5501 WA
GAMEZ] 5501 WAV
GANE2Z 3301 WA
GANEZTSSI WAV
doLFa SSrwAY
HORSERAGE1 50T WAY
Pl B n IYASHDT S30T A
ay Butto KABUKTYO31 SS01 vy

KIKORE! S5 WAY

Plays the audio from || ™™~ |

> (BF
Save to Gamer:

Save ta PG

.-(

the selected settings —t— .,

<@

Play Delete =

Canon

"4

Play Button
| Plays the audio from the
settings file in the
camera.
J_ Displays the settings in
the camera.

L Delete Button
Deletes a settings file
from the camera.

Save to Camera Button

file.

Saves a computer
settings file onto the

camera.

Delete Button
Deletes a settings file from
the computer.

Create a My Camera Sound Button

Starts My Camera Sound Maker (p. 48).
Not available when My Camera Window is opened from the Camera Control Window.

Save to PC Button

Saves a camera settings
file onto the computer.

Gl

You can add new data to the My Camera window. See Adding New Data to

the My Camera Window (p. 47).

Saving the My Camera Settings to the Camera

Gl

¢ My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for

example, all begin with "Animal~".

Do not detach the interface cable, turn the camera power off or disconnect
the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the

computer.
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1 select the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 select the settings file you wish to save to the camera from the My Computer list.

3  select the setting from the Camera list that you would like to change and click
[Save to Cameral.

This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

1 select the [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings files from the Camera list that you wish to save to the
computer.

Click [Save to PC].
Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

Rk N

Create an Original Start-up Image File and then Add It

Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer. Create a JPEG image at a size of (w) 320 x (h) 240 pixels.

1 Open the My Camera window, click the
[Set individually] tab, select [Start-up
Image] from the [Data Type] category 2
and click the [Add File] button. liﬁ:ﬁiiw } =

Select My G

> @f
Save to Camera
Save to PG

B« @

OClose
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Select the file you created and click [Open].

This concludes the process for adding new data.

You can save the newly created data to the camera using the procedures described in the
Saving the My Camera Settings to the Camera section (p. 46).

Create an Original Sound File and then Add It

It is easy to create a sound file using My Camera Sound Maker.
QuickTime is required to play the recorded sound.

Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage
My Cameral.
The My Camera window will display.

Select the [Set individually] tab in the My Camera window and click the [Create a
My Camera Sound] button.

The My Camera Sound Maker program will
start.

=5 My Camera Sound Maker

Start_up Sound Creating

Click. [Recerd] to recard sound ar cick [Open] to apen so

Create a file following the instructions
in the guidance panel.

Instructions

Click & once you have saved the sound file to close My Camera Sound Maker.
This concludes the process of adding a sound file as a My Camera settings file to the
computer.

You can add the file to the camera with the procedures described in the Saving the My
Camera Settings to the Camera section (p. 46).

e Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono WAV
sound file.
*The following chart shows standard time lengths for My Camera
Sounds.
Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains the basic procedures for installing the software. Read this material before
you connect the camera to the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

See ArcSoft PhotoStudio (p. 81) for details on how to install ArcSoft
PhotoStudio.

ltems to Prepare

 Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

N =t

iy
&u) in the CD-ROM window.

4 Click the Digital Camera Software
[Install] button. Ccanon

Solution Disk

Digital Camera Software

—
(e

|

Installer Panel




Installing the Software

Select [Easy Installation] and click
[Next].

Select [Custom Installation] to select
programs individually for installation.

Click [Agree] if you agree to all of the
terms of the software license
agreement.

Review the installation settings and
click [Next].

Follow the onscreen instructions to
proceed.

When the installation is over, click [OK].

Click [Exit] in the installer panel and
remove the disk from the CD-ROM drive.

This concludes the software installation.

50

Selecting an Installation Type

Select an installation type and click INext].

® Easy Installat
a #ms. We recommend this option for users unfamiliar with the
instaltation:

O Custom Installation

Lets you select the programs you want to install. We recommend this option for users
familiar with the installation.

Cancel

—

Starting Installation

Installation will begin using the settings listed below. Click [Next] to start copying files.

Destination Folder:
Macintosh HD:Applications:Canon Utiities

Programs to be Installed:

ImageBrowser
Photostitch
( Cancel ) (_ <Back
"lﬂ Installation has finished.

with these procedures.

See Uninstalling the Software (p. 83) to delete the software installed

Continue by downloading images to the computer (p. 51).




This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 54).

You can also display an index of the camera or memory card images to check
them before downloading or download them selectively. For instructions, see
Checking Images before Downloading (p. 67).

Camera to Computer Connection

Set the ImageBrowser auto start settings before you connect the camera to the computer for
the first time. This step is not required from the second connection onward.

ImageBrowser Auto Start Settings — OS X (v10.2/v10.3)

1. Start Image Capture, click the [Image Capture] menu and select [Preferences].

2. In the next menu, click the [When a camera is connected, open:] list box and select
[Otherl].

060 \mage Capy ' iPhoto e

Sca ¥ ¥ Image Capture
| No application |
When a camera is connected,

3. Select [CameraWindow] in the program selection window.
CameraWindow is generally installed into the folder opened by selecting the
[Applications], [Canon Utilities] and [CameraWindow] folders.

4. Click [OK] and then close Image Capture.

The window will appear
slightly different in v10.2.




Downloading Images to the Computer 52

ImageBrowser Auto Start Settings — OS X (v10.1)
1. Start Image Capture and select [Other] from the Hot Plug Action list box.

‘860 Image Capture

@ Download To: | Pictures, Movies, and Music folders ’1'1
Automatic Task: [ None 3]

Occurs after downloading

Hot Plug Actior v Image Capture Application '
. None

e ——

2. Select [CameraWindow] in the program selection window.
CameraWindow is generally installed into the folder opened by selecting the
[Applications], [Canon Utilities] and [CameraWindow] folders.

3. Close Image Capture.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 95).

The Camera Control Window will appear.
Double-click the [Canon CameraWindow] icon on the desktop if it does not appear.

2 Download images. 000
Download the images using the camera or
the computer. By default, downloaded
images are saved to the [Pictures] folder.

Canon XXXXXXXXXX

—{ Acquire Images | Setto Camera | Remote shooting —

Downloads using camera

| &) D

|-=--ri

Slen

Press the camera's button

Camera Control Window et e

tarts to download images

You can set the type of image to download
and the destination folder by clicking =
[Preferences]. i

,;@ Lets you select and download images
==
Preferences...

B
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Using the Camera to Download Images (Direct Transfer Function)

e If the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the
yas (Print/Share) button will light if your camera is equipped with one.

¢ See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

Set the Direct Transfer settings on the
camera and press the $has (Print/Share)
button or the [SET] button.

Direct Transfer
s All Images...

New Images...
[vi» DPOF Trans. Images...
[ Select & Transfer...
& Wallpaper...

Using the Computer to Download Images
Click [Starts to download images]. 000

Canon XXXXXXXXXX

—{ Acquire Images | Set to Camera  Remote shooting —

Downloads using camera

Press the camera's button

Downloads using computer

f:‘@[ Starts to download images
B

g@ Lets you select and download images
&=

Preferences... ) ( auc )

¢ By default, all the images that have yet to be downloaded are
downloaded and saved to the [Pictures] folder.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

53
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By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ImageBrowser’s Browser Window.

Folder to which the images

5 0515
are saved. [ S0 oi1s
. Do

Thumbnail

Continue by printing out an image (p. 56).

Memory Card Reader Connection

Set the ImageBrowser auto start settings before you connect a memory card reader to a
computer for the first time (p. 51).
This step is not required from the second connection onward.

T insertthe memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card reader for details on how to connect and use the
reader.

(2) Insert the loaded adapter into the slot.

(1) Place the memory card in an adapter if required.

The card adapter and memory card shape may vary
according to the type of memory card your camera

The Camera Control Window will appear.
Double-click the [Canon CameraWindow] icon on the desktop if it does not appear.
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2 click [Starts to download images]. 000

XXXXX

——{ Acquire Images | Set to Memory Card |

Starts to download images

You can set the type of image to download
and the destination folder by clicking
[Preferences].

Lets you select and download images

( Preferences... ) ( Quit )

The downloaded images will be saved into folders according to their shooting date.

¢ By default, all the images that have yet to be downloaded wiill
download to the [Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the type of image for downloading.

*See Memory Card Folder Structure (p. 86) for information about
memory card folder structures and file names.

By default, when the download is complete, the thumbnails (tiny versions) of the

downloaded images will display in ImageBrowser's Browser Window when downloading
is complete.

Continue by printing out an image (p. 56).
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56

Printing Images

Select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [§8 ] (command) key while clicking on images.

eoo
Folder S
(Favorie TAN)
73 Canon Camera
3 Hovies
(3 Pres
b [ 20040513 i
3 20040518
~ [ Flower
3 2004_09_07
[ 2004_09_08
B 2004_09_09
[ 20040910
[ 20040911
[3 2004_09_12
b (3 phoro Lirary
WG._0001_r G002 WG 0005 G WG 0004 75
= yais view (st Al T8) | e @, &, | [ seecing mages )| (31 3 @ A blue frame

displays around
selected images.

Iﬁl Movie images cannot be printed.

Click the [Print] button and select
[Layout printing] from the displayed (@ ‘

menu.

This displays the Layout Options dialog and Internet
the Print window.

Q

Layout Options dialog ‘ece print i

Layout Options d

Preview
How would you like to print your photos?

@ Custom layout printing

O Index printing

Print window

O Fixed photo size printing
O Tiled photo printing

Prints each image at the individually
specified size and position.

From this point onward, the procedures vary according to whether you select Full Page

Print (prints one image per page) or Layout and Print (prints an arrangement of images on
each page).
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Full Page Print

This option prints one image per page.

Select [Tiled photo printing] in the Layout Options dialog and click [Next].

Once you have set the paper size and other settings, select [1 (1 x 1)] in the No. of
images category and click [OK].

Click the [Print] button in the Print window.
This will display the Print dialog.

h W N-

Click [Print] to start printing.

Layout and Print
This option prints multiple images on a single page as in a photo album.

T select [Custom layout printing] in the Layout Options dialog and click [Next].
2 sclect settings, such as the paper size, and click [OK].

3 As required, change the layout and add text in the Print window.

See Print Window Features (p. 58) for the procedures for changing layouts and adding
text.

-

Click the [Print] button in the Print window.
This will display the Print dialog.

Click [Print] to start printing.

*You can print image thumbnails by selecting [Index printing] in the

Layout Options dialog.
¢Images shot with Exif 2.2-compliant cameras (Exif Print) incorporate

information about the shooting settings, such as the camera modes and
settings. Better prints can be made by using this information to correct
the image. To set this function, click the [ImageBrowser] menu and
select [Preferences]. Select [Print] from the list box at the upper left of
the Preferences window and select the desired settings in the [Image
Correction Settings] category.
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Print Window Features

When the [Custom layout printing] option is selected in the Layout Options window, you can
freely change the size and position of the images for printing.

r

8686 Print

Eiowers [ Edit the Page Title
Open the [Edit] menu
and select [Edit
Header].

Change the Image Size
Drag the border to

resize the image. Change the Layout
Drag the images to

change the layout.

Add Captions to Images
Click the image and
then the [Edit] menu
and select [Edit
Caption].

Add Text
Open the [Edit] menu
U  and select [Add Text].

Change the default

number of images Fiokiers
printed per page.
. B Displays the Layout

Vertically and | . -

. . ' : = % = Options window.
horizontally linesup ——&2 & [ e P
images in the RE-LAYOUT  ROTRTE,, P T
window. ezl alc,nadi: 1 7a |z

Displays the Print dialog.

Rotate the selected
image.

To print the shooting date, shooting time or the file name as the caption, click
the [ImageBrowser] menu and select [Preferences]. Select [Print] from the list box
at the upper left of the Preferences window and place check marks besides the
desired items in the [Items to Print in Caption] category.

This chapter explained the ImageBrowser basics.

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform — Advanced Techniques (p. 59).




This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

Browser Window

This window is for displaying and organizing images downloaded to the computer.

Browser Area (p. 60) Display Mode (p. 61)

Favorite

2 Canon Camera
[# Movies
< [@ Pictures
b [72004_05_13
[ 2004_05_18
~ [ Flower
| [ 2004_09_07
[ 2004_09_08
¥ 2004_09_09
[ 2004_09_10
[ 2004_09_11
[ 2004_09_12
b [ IPhoto Library

1600 1200
PG

Add to Favorites
T View Image Siideshow Iternet o Print S

\

Explorer Panel (p. 60) Display Control Panel (p. 62) Control Panel (p. 62)




The ImageBrowser Windows 60

Explorer Panel

¢ Use this area to select folders. The images in the selected folder display in the Browser Area.

o If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o If [Favorite Folders] is displayed: click [Add] and select a folder.
o |f [All Folders] is displayed: select a folder and click [Add to Favorites].

Browser Area

*The images in the folder selected in the Explorer Panel will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

e Selecting a single image: click on an image.

e Selecting multiple images: click on the first image and then hold the [shift] or [§§ ]
(command) key down while clicking on additional images.

e Selecting consecutive images: click on the first image and then hold the [shift] and
[option] keys down while clicking on the last image.

¢ The following types of icon will display around images according to their attributes.
Chal Images shot with the camera's Stitch Assist mode
RAW images
‘- Movies
F.Iﬂ Images with sound memo attachments
[ Protected images

Sy Images shot with the camera's AEB function
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Display Mode

o Selects the display style for the Browser Area.

Preview e

H H H H review | List imeTunnel -
This mode displays the image at a larger size as Crssen |t ToveTomel T,;é SISEEREEET
well as the image information.

File Name. 1MG_0001
Madification Date: Sun, May 2,
File Size: 580K8
Image size: 1600 1200
File Format: IPG

Suund:

Lock: -

 Favorite Rating

IMG_0001.JPGIMG_0002. JPG IMG_0003.JPGIMG_0004. JPG IMG_0005. JPGIMG_0006. PG IMG_0007.JPG

List Browser Window

Displays the images in the folder selected in the e
Explorer Panel section in rows and columns.

IMG_0001.JPG IMG_0002.JPG IMG_0003./PG IMG_0004.JPG

IMG_0005.JPG 1MG_0006.JPG IMG_0007.JPG

TimeTunnel

Displays images in chronological order in a
simulated time tunnel. You can move along a
timeline from the past to the present using the
slider that appears at the window's right.

20011
—

111000 @ 0

[

61
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu

Changes the size of the thumbnail in Use this to select or deselect all

the Browser Area. the images in the Browser Area.
View  Show All [ a @ ‘ | Selecting Images v| ( @)

I I 1 I 1 I

Filter Images Hide Buttons —mM8 ——
This feature filters your images by their Star Left:  Hides the Explorer Panel.
Ratings, displaying only those images in the Middle: Hides the control panel.
Browser Area. Right: Hides the image
One of three Star Ratings can be assigned to information in the Preview
an image in the Viewer Window, the File display mode.

Information Window, or in the information
column in the Preview display mode.

Control Panel
¢ The control panel contains buttons for executing various functions.

i ) 2 = |

Canon Camera View Image SlideShow Internet - Print - Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 65).
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Double-click an image in the Browser Area to display it in the Viewer Window.

e 0 e -4 IMG_0001 JPG

zoom setting.

Image Selector 4 &
Button L :ack Hext “M“z:‘:ve Edit - Pisphys  w Synchronize _ hF\j\Iﬁcreen ;s"ﬁhvw AF Frame 4
Switches between - ‘
images. Star Ratings Mer)u
Save Button Sets th_e Star Rating
Saves the edited for an image.
image.
Edit Menu —
Allows trimming and color Show AF Frame
adjustment. Displays the AF Frame (area
You can also use it to start up used to focus).
other programs for editing. Full Screen Button
. Displays the image in the full
Number of Displays Menu — screen mode. Click the image or
Displays multiple images at press any key on the keyboard to
once. This is handy for restore the normal display mode.

comparing images.
Synchronize Button
Synchronizes the display
settings when multiple
images are displayed.
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File Information Window

The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview
display mode.

Star Rating Menu
Sets the Star Rating for an image.

o0oo File Information

Shows or hides

wstar Ratfg

categories. .
TS Comment
|_You can type a comment
here.
L —
i b e e Keyword
Plays asound memo —m=r o M Keyword
attached to an image. i | I — e Sets the keywords used in
ietomac | pc searches.
e
Histogram
Lock b o A graph of the highlights
Prevents an image Yo e and shadows distribution
from being rom in an image.
overwritten or [
deleted. o
Image Selector Buttons Shooting Information
Switches between images. Displays detailed information

about the shooting settings when
the image was captured, such as
the shutter speed or exposure
setting. The camera model will
determine what information is
displayed.




ImageBrowser Features 65

ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

3 4 9 B 8

Canon Carnera Yiew Image SlideShovw Internet - Print - Send to Trash

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 51, 54).

Set to Camera
Sets camera settings, such as the My Camera settings (p. 77), or Slide Show/DPOF settings. It
also uploads images from the computer to the camera/memory card.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 73).

View Images
Displays the selected image in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.

Internet
Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.
Print
Layout Printing
Allows you to arrange the selected images in an attractive layout and print them (p. 56).

Index Printing
Prints the selected images as an index.

Send to Trash

Sends the selected images or folders to the Trash.
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Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches images by criteria such as Star Rating, dates, keywords, comments.

Export Images: [File] menu, [Export Images]
eEdit and Save: allows you to change the file type or size and export the file.
eExport Shooting Properties: allows you to export the shooting properties as a text file.
eExport as a Screensaver: Exports the image as a screen saver file.
eExport an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date and time or Star
Rating and saves them into a specified folder.

*Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]

Converts RAW images. You can adjust the image brightness, contrast and color balance
among other attributes during conversion (p. 71).

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 76).

Edit Movies: [Edit] menu, [Movie Edit]

Edits movies or still images strung together. You can add titles or background music and apply
various effects (p. 70).

Display Settings: [View] menu, [View Settings]

Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]

Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.
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Checking Images before Downloading

Checking Images before Downloading

You can display camera or memory card images in the Camera Browser Window to view them
before downloading.

1 Perform Step 1 in the Camera to Computer Connection section (p. 51) or steps 1-2
in the Memory Card Reader Connection section (p. 54).

The Camera Control Window will display.

2 click [Lets you select and download 00 Canion XXXXXXXXXX

images].
9 ] —[Acquire Images | Setto Camera  Remote shooting | —

Downloads using camera

o D

-

Downloads using computer

Press the camera's button

i{gﬁl Starts to download images

b Lets you select and download images

Preferences... )

The images in the camera or memory card will display in the Camera Browser Window as
thumbnails (tiny images).

[ XaXe) Camera Window - Canon XXXXXXXXXX
[ Download Images | % [(Large M= =8 &
- = = - Camera Browser
—[“Bright. | RGB ) Wi
indow
L H
Thumbnail
I
IMG_0004.)PC
Conan i DIGTALL
4 05/12/04 13:52:28
Detailed Information
fie
e
camara o tame
T BlTR L
Sncatog B e
B
Srocing wode
e
o e
Tw(ShutterSpeed )
IMG_0005.JPG IMG_0006.JPG IMG_0007.JPG Al Aperture Value ¥

Light Metering

7

3 select images to download.
To select multiple images, click on the first image and then hold down the [shift] or [§§]

(command) key while clicking on successive images.
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4 Click [Download images]. ann Camera Window - Canon XXXX>
[@ Download Images ] | %‘ Large I:} = | ‘ i< | I
1 2 3

IMG_0003.JPG

“
P2
WY

5B Confirm the destination folder and click PO T
[Start Download]. -File name setings

Do not modify [
File Prefix

Specify the file name for saved images. ——— e

Assign Sequence No.

Number of n
Start 1
Example

Specify the destination folder for the
images. | e
You can change the destination folder by

Save to (Folder Name)
05¥-Panther: Users: X}XX: Pictures
clicking [Browse] and selecting a new

(300¢Extention type of image file is unchanged. )

Browse. ..

destination.
¥ Create Sub folder
Shooting YearMonthDate [ ]

Select [Create subfolder] to create a new _| New Name

folder within the one specified above, and IMAGE

Se|eCt a namlng Optlon Bample: (" ] éf)‘*PHn(hEYUSEYE SOOK:Pictures

(7] 2003_12_31
A;

:

The thumbnails of the downloaded images will display in the Browser Window of
ImageBrowser when downloading is complete.

You can also download images to the computer by dragging images displayed in
the Camera Browser Window and dropping them onto the Browser Area or
Explorer Panel in ImageBrowser.

Other Downloading Methods

Your digital camera employs a standard image transfer protocol called Picture Transfer
Protocol (PTP). With PTP, you can use the programs supplied as standard software with
Mac OS X, such as iPhoto or Image Capture, to download images simply by connecting
the camera to the computer with the interface cable. (In this case, ImageBrowser does
not need to be installed.) However, there are some inconveniences and limitations to
this downloading method. See the leaflet entitled For Windows® XP and Mac 0S X

Users for details.
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Replaying Movies

1 Double-click an image with a movie icon in ImageBrowser’s Browser Area.
The movie will appear in the Viewer
Window. — -

Movie icon

2 Click the [Play] | # | button. —

[ a

s Mmoo
Mo sz 20210 Doy
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects

to the movies.

1 selectthe image(s) to edit in ImageBrowser’s Browser Area (movies or stills).

You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit].

3 Follow the steps displayed in the middle of the window to edit the movie and save

it.

— Follow these steps
to proceed.

‘@006 MovieEdit Task

Arrange images.

2. Click the [Play] button to playthe arranged effects and check them
3. Click the [Effect] tab to go to Effect Step.

1. To arrange images, select the image and click on the [Move Left] or [Move Right] button

Instructions

LArmange 2,Effect 3 Audie 4.5ave

—DW@L@GE«@M‘

Play AddImage  Play Time Rotate  Moveleft  Move Right Properties Clear

ERE!

I = =)

Click this button
for detailed

Reduce

==

operational
instructions.

5

=

— Click this button
to play the movie
being edited.

Storyboard Area

Displays thumbnails of the
selected images.

Links images in order from
left to right.

k<r—%

Transition Effect Box
Appears between adjacent
images and displays the
symbols of the transition
effects linking images.
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Converting RAW Images

RAW images are extremely high-quality images that are not subject to any deterioration due to
compression processing. Since they are a special type of image, they cannot be opened by
many image editing programs. It is first necessary to convert them into standard image files.

camera model supports this function.

shooting RAW images.

¢ See Information about Your Camera (p. 95) to determine whether your

¢ See the Camera User Guide for information about the camera settings for

Procedures for Converting RAW Images

Select a RAW image in ImageBrowser’s Browser Area.
Click the [File] menu and select [RAW Image Processing].

Click [OK] when a window displaying procedures for converting and adjusting RAW

images appears.

The main window, the Navigator window and the Image Quality Adjustment Window will

display.

Use the buttons here to switch
between images and display
modes, rotate images, and set
the conversion parameters.

RAW Image Task

Main Window

Navigator Widow

a0 L Navigatar

~Adj ge | 2.5ave | 3. Exit )]

2 88 [E3

tate o Select y  Transfer

CRW_0015.CRW

Thumbnail

Check Mark

When the preview image
in the main window is
zoomed, you can change
the portion shown in the
preview by clicking and
dragging this red symbol.

select [Show Navigator].

5

If the navigator window does not display, click the [View] menu and

3 Adjust the image quality as required in the Image Quality Adjustment Window.
This window is explained in the Functions of the Image Quality Adjustment Window

section.
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4 Click the [2. Save] tab, set the file type  eao s e T
and destination, and then click [Savel]. AR ,
@fl\xmages
File Format: Exif-TIFF(8bit/ch) ‘:]
Select [All Images] or [Checked Images] e : 5
(images checked in the main window) to e T
apply the common conversion settings. e flcer

@ save in Original Image folder
Osa ified folder.

Select a file type

Rename File
Do Not Modity
i Example

Set the file destination ey

Number of Digits i -9

You can also change the file name

This will convert the image.

5B Click the [3. Exit] tab and click [OK].

Functions of the Image Quality Adjustment Window

The following adjustments can be made in the Image Quality Adjustment Window. The
available settings may vary depending on the camera used.

O O 0 Image Quality Adjustment I

JHRKKAKHNK Tone Curve Tab
( You can set the levels for

Tone Curre

This section adjusts the O the RGB channels

. . White Balance
white balance according = B separately or together.
to the light source and it
color temperature. = s K Advanced Adjustments
Magenta Green s Tab
This section adjusts the © e You can set the settings
digital exposure P T ET— S for adaptive noise
c?;npensatlon, photo —_—— control and the color
e ECt: contrast, (-2.0-+2.0) Space for the OUtpUt-
sharpness, and saturation. Photo Effect Click the arrow to
—_ display the tab.
Restores all settings to the Contrast
. B _e_ 0
settings stored in the = s If you cannot set the
camera at the time of LR & = desired setting with the
shooting. — (s-10) slider on the left,
The effect of the settings = ) girectly enter the setting
\ [ERIRY, ere.
above can be viewed
immediately if you place a Shot settngs v —— Applies the settings to

check mark here. e the displayed image

You can change the coloration of the image to your preferred settings when
you convert a RAW image. You can also select preset color schemes, such as
Positive Film. Furthermore, you can add your own color schemes (My Color) to
apply to other RAW images when they are being converted.
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Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

¢ Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 95).

¢ Perform the settings described in ImageBrowser Auto Start Settings
(p. 51) the first time you connect the camera to the computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 Click the [Remote shooting] tab. 000 Canon XXXXXXXXXX

[ &
—!" Acquire Images | Setto Camela ' Remote shooting ]—

EJ Starts Remote Shooting

Preferences &)

4 cik [Starts Remote Shooting].

5 select a destination for the captured images and click [Choose].
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Size and Resolution Selector
Selects the size and resolution at which
images are captured.

Shows/Hides the
viewfinder or
detailed settings

area. . .
Rotation Settings
eon ey 1172 175 Sets the rotation
v Hide ViewFinder G E Gt _parameters for
¥ Hide shooting details rj:j 0 Fadl Images after they are
You can add = [ Add comments shown below Captured.

comments to images
by placing a check
mark here and
typing text in the
boxes below.

Release Button
Releases the
shutter.

g

Slide this to zoom
the camera in or out.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to

the camera is open to ;} Field angle/flash __Shooting settings |
display the image

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Focusing Point: Flash:
appearing in the Manual selectio... [%] | Off )| Refresh Button
camera'’s viewfinder. Macro: FlashQuality: Resets the exposure,
Off B | focus and white
AF-assist light: balance.
On H
AF operation:
AF unlock 3

Set the basic camera settings here.

*The settings available in the RemoteCapture Task window vary between
camera models.

* RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click to reset these settings.
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Remote Shooting

Ensure that you turn off your computer’s sleep mode before you begin remote
shooting. The device performance cannot be guaranteed if the computer
enters the sleep mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

If your camera is equipped with the Auto Rotate function and you set it
to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window.

3 Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge images
if they are shot with the camera's Stitch Assist mode because PhotoStitch can automatically
detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

—
Symbol displayed by images shot in Stitch Assist @
mode. _U

e See the Camera User Guide for information about shooting in
Stitch Assist mode.
eImages shot in Stitch Assist mode with a wide converter,
teleconverter or close-up lens cannot be merged accurately.

Starting PhotoStitch

1 select a series of images in the ImageBrowser’s Browser Area.

Click the [Edit] menu and select 000
[PhotoStitch]. [ . [Mergeimages Shot in Stitch Assist Mode

Click [2. Merge] to merge these images.
For images shot as a 360-degree panoram:
[360 Degrees] and then click [2. Merge].

a, click [Arrange], select

Instructions

STA_B783.JPG

STB_97584.JPG STC_8795.0PG

Ho. of Images: 3 2592 1944 True Color.

3 Merge the images following the
instructions in the guidance panel at the top of the PhotoStitch window.

76
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

* Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera section (p. 95).

* Perform the settings described in ImageBrowser Auto Start Settings
(p. 51) the first time you connect the camera to the computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab. A

]

0 Canon XXXXXXXXXX

—! Acquire Imagfs | Setto Camera | femote shooting —

7

el

Set My Camera

Set Slide Show/DPOF

Confirms/changes camera settings

& &R

"_Eﬂ Uploads images to the camera

Preferences 4 Quit )
3 Cclick [Set My Cameral.
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The My Camera Window

ImageBrowser already contains several pre-recorded My Camera settings items. You can check
these items with the My Camera window.

Type
Select the settings type. B ggx: :g Ezm:':ter Play Button
Plays the audio from
the settings file in the
camera.
Displays the list ——
of settings files My Camera )
saved onto the Type{ Theme 3] Displays the
computer_ Camera (Only editabl items display) settlngs in the
[= \ o camera.
321 =
ANIMALD22Z ¢ Play (__ Delete..  S—— Delete Button
023 Deletes a settings
BASERALL21 file from the
Add Button ( Add. ) (  SendtoTrash ) camera.
Adds the settings Play Canon
flle to the IISt Save To.@SX-Panther:Users:XYXX:Library:Preferences:imageBrowserUserData:
MyCamefaFiles:
Save to Camera
Play Button Send to Trash Button Save to Camera Button
Plays the audio from the Deletes a settings file Click here to save the
selected settings file. from the computer. settings onto the
camera.

You can add new files as My Camera settings to the My Camera window. See
Adding New Data to the My Camera Window (p. 80).
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Saving the My Camera Settings to the Camera

¢ My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with “Animal~".

Do not detach the interface cable, turn the camera power off or disconnect

0 the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

Select the type of setting in the Type list box that you wish to save to the camera.
Select the setting from the Computer list that you would like to add.

Select the setting in the Camera list that you would like to change and click the
button.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

W=

4 Click the [Save to Camera] button.

This concludes the process of saving the My Camera settings to the camera.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

Select the type of setting you wish to save to the computer from the Type list box.
Select the setting in the Camera list that you wish to save to the computer.

Click the button.

Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

RWN=
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

Create an Original Start-up Image File and then Add It

Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer. Create a JPEG image at a size of (w) 320 x (h) 240 pixels.

1 Open the My Camera window, select [Start-up Image] from the Type list box.

2 Click the [Add] button. ANIMALO23
3 Select the file you created and click ;EEQALLH <
[Openl. +
This concludes the process for adding new €—add—) Send to Trash
data. —TPor—
YOU can save the nery Created data tO the Save To:0S8X-Panther:Users:XXXX:Library:Preferences:ImageBrows
camera using the procedures described in MyCameraFiles:
the Saving the My Camera Settings to the Save ¢

Camera section (p. 79).

Add an Original Sound File

Change the file to a WAV sound file after you have copied the sound file to the computer. Then
proceed with the steps as described in Create an Original Start-up Image File and then Add It.

eRecord the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono WAV
sound file.
¢ The following chart shows standard time lengths for My Camera Sounds.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter introduces the CD-ROM supplied with your camera and the procedures for
installing the programs. It also explains how to uninstall the programs.

Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

ArcSoft PhotoStudio

ArcSoft PhotoStudio is a high-performance yet easy-to-use image editing program from
ArcSoft, Inc. It can process, edit and print images. It includes color corrections, brightness
adjustments and special effects. Install it from the supplied CD-ROM, the Canon Digital Camera
Solution Disk, as required.

Installing ArcSoft PhotoStudio

Windows

1 Closeall programs that are running.

2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel displays, click [Exit] to close it.

3 Click the [Start] menu, and select [My Computer]. Windows 2000, Windows Me
and Windows 98 users, double-click the [My Computer] icon on the desktop.

4 Right-click the CD-ROM icon and select [Open].

5 Double-click the [ARCSOFT] folder or right-click it and select [Open], and double-

click the [SETUP.EXE] icon EN.
Follow the onscreen messages to proceed with the installation.

Macintosh

1 Ccloseall programs that are running.

2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3 Open the CD-ROM and double-click [ARCSOFT], followed by the [PhotoStudio
Installer] icon [ .
Follow the onscreen messages to proceed with the installation.

]

Click [OK] when a message appears stating that the installation is complete.
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Starting ArcSoft PhotoStudio

You can start ArcSoft PhotoStudio from within ZoomBrowser EX (Windows) or ImageBrowser
(Macintosh).

ZoomBrowser EX

1 dik [Edit] in the Task Area of the Main Window, followed by [Edit Image].

2 Confirm that [1. Select Images] is selected and select an image to edit. =

3 Click [2. Select Editing Tool] and select [Edit with external image editor]. §-

4  sclect ArcSoft PhotoStudio from the program list and click [3. Finish]. i

=
If you cannot select ArcSoft PhotoStudio, register the program using the §
following procedures. =3
1.In Step 3 above, select [Edit with external image editor] and click £
[Manage List].

2.Click [Add] and select [ArcSoft PhotoStudio].

ImageBrowser

1 selectan image to edit, click the [Edit] menu and select [ArcSoft PhotoStudio].

Manval for ArcSoft PhotoStudio

You can obtain the ArcSoft PhotoStudio manual from the ArcSoft, Inc., website. Use your
browser program to download the manual from the following URL:
http://www.arcsoft.com/support
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Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk (excluding
ArcSoft PhotoStudio)

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.

=
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1 Click the Windows [Start] menu and
select [All Programs] or [Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

The uninstall utility will start and remove
ZoomBrowser EX.

*You can remove other programs with the same procedures.
¢ To uninstall CameraWindow, be sure to follow the following
procedures.

1. Click the [Start] menu and select [All Programs] or [Programs],
followed by [Canon Utilities], [CameraWindow], [PowerShot - IXY-
IXUS - DV] and [CameraWindow Uninstall].

2. Click the [Start] menu and select [All Programs] or [Programs],
followed by [Canon Utilities], [CameraWindow], [EOS Digital] and
[CameraWindow Uninstall].

3. Click the [Start] menu and select [All Programs] or [Programs],
followed by [Canon Utilities], [CameraWindow] and [CameraWindow
Uninstall].

* PhotoRecord can be uninstalled by clicking the Windows [Start] menu
and selecting [All Programs] or [Programs], followed by [Canon

PhotoRecord] and [PhotoRecord Uninstall].

Uninstalling ArcSoft PhotoStudio

ArcSoft Camera Suite 2.1, ArcSoft Camera Suite 1.3

¢ Uninstall the program by clicking the [Start] menu and selecting [Control Panel] and [Add or
Remove Programs].

¢ With Windows 2000/Me/98, uninstall the program by clicking the [Start] menu and selecting
[Settings] followed by [Control Panel] and [Add/Remove Programs].
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Uninstalling the USB Driver (Windows)

Uninstall the USB Driver using the following procedures if you are using Windows 2000,

Windows Me or Windows 98 SE.

0 It is essential to note that you will not be able to download images if you

uninstall the USB driver.

Iﬁl You do not need to uninstall the USB driver with Windows XP.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

For interface cable connection instructions, see Information about Your Camera (p. 95).

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select
[Settings], followed by [Control Panel].

4 Double-click the [Scanners and
Cameras] icon or folder.

% Windows Update

winzip

~{ et Program Access and Defauls

| Programs

Documnenks

Search L4

Printers

Heln i Taskbar & Start Menu...

Run.

Shut Down, ..

dhstare [ ] & 5 © []

3 Control Panel i

Fle Edt View Favorites Tools Help
G Back - = - [2] | @Search [hFokers (3|05 T X o | EE-
Address [ Control panel
g i = -
J =

" Accessiiity  AddfRemove  Add/Remove Administrative  Adtomatic C
Control Panel Options Updates

ior Hat
u
Use the sektings in Cantral Panel ta Cﬁf o

persondlizs your computer.
Display ~ Folder Options  Forks Tternet K
Select anitem ko viswsits description. Gptions Options

ﬂ
€

Frograms

Bt
L~

windows Update . ey
i L
Windows 2000 Support g ]
Mouse  Metnorkand  Phone and  Power Options  Printers
Dishup Co...  Modem ..
¢ a8 B
Scanersand  Spfieduied  Soundsand  System  Usersand

Cameras asks Hukimedia Passwords
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5 Delete your camera model name or 2]
[Canon Camera] in the [Scanners and

Cameras Properties] dialog.
Windows Me users should delete their %

camera model or [Canon Camera] |n ‘the The | m nners of cameras are installed :
[Scanners and Cameras] folder.

Devices |

=
—1
3
b
Add, ( Remove h‘ E
Tmuhlashuutl ==y 2
=
Windows 2000 a
Select your camera model name or [Canon Camera] and click [Remove]. =
Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select
[Delete].

Windows 98 SE
Select your camera model name or [Canon Camera] and click [Remove]. Then turn off the
camera and remove the interface cable from the computer's USB port.

If your camera model name does not appear here, see the Camera not
detected, Events dialog won't display or images will not download to the
computer (p. 88) of the Troubleshooting section.

6 Click the Windows [Start] menu and select [All Programs] or [Programs], followed
by [Canon Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A
version number appears in place of the “x.x".
¢ Windows 2000, Windows 98 SE: Perform Step 6 with no substitutions.
¢ Windows Me: Substitute the following for the underlined portions of Step 6.

[Camera WIA Driver x.x], [Uninstall WIA Driver]

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following
procedures.

1. Reinstall the driver.

2. Connect the camera to the computer with the interface cable.

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.

Please be careful not to accidentally delete any folders with downloaded
images that may be contained within the application folder.
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Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders labeled
[xxxCANON], where the “xxx" represents a number in the range 100 - 998.

— IMG_xxxx.JPG (JPEG images)
EI T — _MG_xxxx.JPG (JPEG images recorded in the

DCIM Adobe RGB color space)
XXXCANON | cCRW_xxxx.CRW (RAW images)
—— _RW_xxxx.CRW (RAW images recorded in the

Adobe RGB color space)
F— CRW_xxxx.THM*
—— STx_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.AVI (Movies)
—— MVI_xxxx.THM*
—— SND_xxxx.WAYV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.
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CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC

¢ *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

eThe “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

o All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.
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Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

Does your computer satisfy the requirements listed in the System
Requirements section (p. 8)?

5
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@ Is the camera correctly connected to the computer?
Q

See Information about Your Camera (p. 95) for the correct connection
procedures. Also check to ensure that you are using the correct cable and
that it is securely attached at both ends.

? Is the camera set to the playback mode? (some models only)

Some models require the camera to be set to the playback mode to
transfer data. See Information about Your Camera (p. 95) for details.

@ Is the battery sufficiently charged?
Q

Check the battery charge if you are powering the camera with a battery.
You are recommended to use a household power source (AC adapter) to
power the camera when it is connected to a computer (if available for
your camera model).

Problems

Try the suggested solutions to the common problems listed below.

? USB driver installation not proceeding well (Windows)

Uninstall the driver (p. 84) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 10).
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?

?

?

Q

Add New Hardware Wizard or New Hardware Found (Windows 2000)
Wizard displays when the camera is connected to the computer with an
interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

Images won't download into a TWAIN-compliant program (Camera and
computer connected via interface cable (Windows 2000, Windows 98 SE)).

Click the [Finish] button in the Camera Control Window to close it.
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Camera not detected, Events dialog won’t display or images will not
download to the computer (when camera is connected to the computer
via an interface cable).

Cause 1:

There is a problem with one of the items in the Start by Checking This
section (p. 87).

Solution:
Resolve the problem.

Cause 2:
The USB driver is not installed (Windows only).

Solution:
Install it with the procedures in Installing the Software and USB Driver (p. 10).

Cause 3:

The USB driver is not correctly installed (Windows only).

Solution:
Uninstall the driver (p. 84) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 10).

Cause 4:

The camera may have been recognized as another device under the

following circumstances (Windows only).

® The camera was connected to the computer before the USB driver was
installed.

¢ The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot
be found in the [Control Panel] or the [Printers and Other Hardware] window.

* Your camera model name, [Canon Camera] or a camera icon does not display
in the [Scanners and Cameras Properties] dialog or the [Scanners and
Cameras] folder.
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Solution 1:

Start with the following procedures.

Install the USB driver with the procedures in Installing the Software and USB
Driver (p. 10). Then connect the camera to the computer with the interface
cable and prepare it to transfer data. If the USB driver is already installed,
uninstall it first and then reinstall it.

Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue by

implementing the following procedures. The specific steps are explained below.

1. Check to see if the camera is being recognized as an “other” device.

2. Delete the driver and the setup information files if it is being recognized as an
"other” device.

3. Reinstall the driver.
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This section explains the specific steps for each operating system.

Windows XP and Windows 2000

Users of Windows XP and Windows 2000 must first log in as an
Administrator (computer system administrator) to delete a driver.

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Windows XP: Click the [Start] menu, followed by [Control Panel],
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control
Panel]. Double-click the [System] icon.

. Click the [Hardware] tab, followed by [Device Manager].

. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.
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=| There are other potential reasons for the problem if the "Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.
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4. Select your camera model name or [Canon Camera], right-click and select
[Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Close the System Properties window.

Iﬁl Step 7 and above are not required for Windows XP.

Delete the setup information files
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7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINNT] folder and [inf] folder.

If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

. Open the [WINNT] folder.

. Click the [Tools] menu and select [Folder Options].

. Click the [View] tab.

. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files
and folders] to [Show hidden files and folders]. Remove the check marks from [Hide
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

MWN =

This will make the hidden files and folders visible.

General View | File Types| Oifine Fes |
Taol: T
Map Witises D ‘You ean set all of your folders to the same view.
Dizconnect Metwork Drive... » [ Bt |
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Falder Options. ..

Festore Defaults
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8. Look for files for Canon digital cameras that start with [CAP*].
The "*" represents a number, such as 0 or 1.
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files (For example,
[CAPQ.inf] and [CAPQ.pnf]).
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9. Double-click the [CAP*] files to check their contents.
Double-clicking an [CAP*.inf] file will open it in the Windows Notepad
program. Look for [;****Canon Camera Driver Setup File****] in the first
line. Note down the names of these files.

Several sets of [CAP*] files may be present in the [inf] folder. Open up
each file to confirm that it is an [CAP*] file for Canon digital cameras
before you do anything with the file.

10.Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you
noted down in Step 9.
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The [inf] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

Reinstall the driver.

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 10).

Windows Me/Windows 98 SE

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Click the [Start] menu and select [Settings], followed by [Control Panel].
Double-click the [System] icon.
This will display the System Properties window.

. Click the [Device Manager] tab.

. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.
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or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.

Iﬁl There are other potential reasons for the problem if the “Other devices”

. Select your camera model name or [Canon Camera] and click [Remove].

. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Click [OK] to close the System Properties window.
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Delete the setup information files.

7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINDOWS] or [Windows] folder and [INF] or [Inf] folder.

If the [INF] Folder Is Not Visible in the [WINDOWS] Folder
Use the following procedures to show all files and folders.

1. Windows 98 SE: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. Windows 98 SE: Set the [Hide files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show hidden files and
folders].

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Find and delete the [DRVDATA.BIN] (or [Drvdata.bin]) and [DRVIDX.BIN] (or
[Drvidx.bin]) files.
9. In the [INF] or [Inf] folder, double-click the [OTHER] or [Other] folder to open
it.
10. Find and delete the [Canon.IncCAP xxx.Inf] file (The xxx
represents numerals.).

You do not need to delete anything if none of the above files are
contained in the [OTHER] folder.

The [INF] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.
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Reinstall the driver

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 10).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel] and
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98 SE, click the [Start] menu
and select [Settings], followed by [Control Panel].

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab,
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98 SE, click the [Display] icon, followed by
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].

4. Restart the computer if prompted.



Troubleshooting | 94

If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 5.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

. Double-click [dbconverter.exe] found in this folder to start this utility.

. Select the database file you were using up to this point and click the [Start]
button.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)
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This will display the titles and comments input in the earlier versions in the
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder

Image files in the [Program Files] folder or a subfolder cannot be displayed in
ZoomBrowser EX 5 from that location. To display these files, first perform steps
1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains from the
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser
EX\Library One to another location.)

The moved folder images can now be selected and displayed with
ZoomBrowser EX 5.



The software package and the procedures for connecting to a computer and preparing for data
transfers vary between camera models. Certain software functions may also not be supported
by some camera models.
Read this section to confirm the capabilities of your camera model.

Information Common to All Models

See the respective page for your camera model for information specific to that model (p. 95).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It
contains the following programs.

Windows Programs

Compatible OS | Windows | Windows | Windows | Windows . .

Program 98 Me 2000 XP Major Functions
*3 Downloading, displaying,

ZoomBrowser EX g L d L d ® organizing and editing images

. *3 =4 | Driver for Canon brand cameras (for
TWAIN Driver o - ® - Windows 98, Windows 2000)
WIA Driver - o — —*4 | Driver (Windows Me)
PhotoRecord*1 o3 ) ) @® |Llayout and printing
PhotoStitch*1 o3 o o o Merging images to make panoramas
ArcSoft PhotoStudio™1 *2 o ) ) @® | Advanced image editing

*1 Can be started from within ZoomBrowser EX.
*2 Image editing program manufactured by ArcSoft, Inc.

*3 Compatible with Windows 98 SE only.

*4 Driver not required because Windows XP supports PTP.

Macintosh Programs

Program Compatible O3 MacOS 9 | Mac OS X Major Functions
ImageBrowser - ) Downloading, displaying, organizing and editing images
PhotoStitch*1 - o Merging images to make panoramas

ArcSoft PhotoStudio™1 *2 - ) Advanced image editing

*1  Can be started from within ImageBrowser.
*2  Image editing program manufactured by ArcSoft, Inc.

YSOJUDY/SMOpUIM
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Connecting the Camera to a Computer

Ensure that you have installed the software from the supplied Canon Digital
Camera Solution Disk before you connect the camera to the computer.

ltem to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera
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¢ Use the interface cable to attach the camera directly to a USB port on the
0 computer, not through a USB hub. The connection may not operate correctly
through a USB hub.

*The connection may not operate correctly if you are using other USB devices,
excluding USB mice or keyboards, at the same time as the camera. If this
occurs, disconnect the other devices from the computer and try reconnecting
the camera.

* Do not connect two or more cameras at the same time to the same computer
via the USB interface. The connections may not operate correctly.

¢ Never allow the computer to go into standby (sleep) mode while a camera is
connected via the USB interface. If it does happen, never disconnect the
interface cable. Try to awaken the computer with the camera in the
connected state. Some computers will not awaken properly if you disconnect
the camera while they are in standby (sleep) mode. Please refer to your
computer manual for instructions regarding the standby (sleep) mode.

You are recommended to power the camera from a household power source
(AC adapter) when connecting to a computer (if available for your camera
model). Ensure that you use fully charged batteries if you will not be using a
household power source.

See the page (p. 95) for your specific model for information about connecting the camera to
the computer.



PowerShot A520/PowerShot A510

PowerShot A520/PowerShot A510

How to Connect the Camera to a Computer and Prepare fo Transfer Data

97

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal.

Set the mode switch to Play and turn the camera power on.
The camera and computer will be set to the correct mode for communicating.
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Non-Supported Programs and Features

*The camera does not record RAW images.

*The camera does not support the Show AF Frame function in the View
Window.

¢ICC profiles cannot be imbedded in images. For details on the ICC profile
function, see the ZoomBrowser EX/ImageBrowser PDF manuals.

DIGITAL IXUS 700
DIGITAL IXUS 50

How to Connect the Camera to a Computer and Prepare fo Transfer Data

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal.

Set the mode switch to Play and turn the camera power on.
The camera and computer will be set to the correct mode for communicating.

Non-Supported Programs and Features

*The camera does not record RAW images.
*The camera shutter cannot be controlled from a computer.

*The camera does not support the Show AF Frame function in the View
Window.

¢ICC profiles cannot be imbedded in images. For details on the ICC profile
function, see the ZoomBrowser EX/ImageBrowser PDF manuals.
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Canon Customer Support

For Canon Customer Support contacts, please see the European Warranty System
(EWS) Booklet supplied with your camera.

ArcSoft Customer Support
North America

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.
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